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LEARNING OBJECTIVES OF MODULE 1

Learn about the causes and impacts of eutrophication in water ecosystems

Familiarize yourself with the history of remote sensing and chlorophyll-a (challenges and solutions)

Identify the satellites used for water quality monitoring

Download freely available satellite images 

Learn how to calculate chl-a concentrations from satellite images using ESA’s SNAP toolkit

Use the PONTOS Data Cube to calculate Total Suspended Matter (TSM) concentrations 
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MODULE STRUCTURE

Using the PONTOS Data Cube to calculate 
Total Suspended Matter04

Using remote sensing to monitor 
eutrophication dynamics02

Eutrophication in water ecosystems (causes 
and impacts)01

Calculating chl-a using the SNAP toolkit and 
C2RCC processor03
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Eutrophication in water ecosystems 
(causes and impacts)01

This section will introduce you to the 
classification of water ecosystems and 
their trophic states, issues related to water 
quality monitoring, eutrophication and its 
drivers, as well as, the importance of 
ensuring the good status of water bodies.

Image source: ConserveEnergyFuture
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Eutrophication in water ecosystems 

Aquatic ecosystems are classified into 3 main trophic states 
(i.e. nutrient content):

1. Oligotrophic systems:
Characterized by very low nutrient content (likely nitrogen (N) 
and/or phosphorus (P) being a limiting factor, thus very low 
productivity. Very high water transparency. 

2. Mesotrophic systems: 
Higher nutrient content leads to higher primary productivity (more 
plants and algae), likely higher secondary productivity, lower water 
transparency due to higher dissolved organic matter and algal grow

3. Eutrophic systems: 
Very high nutrient content, excessive algal blooms, turbid waters.
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Eutrophication in water ecosystems 

Eutrophication is the process of excessive algal 
growth due to increased nutrient (particularly N 
& P loading). 

Eutrophication can lead to:
● Increased BOD (Biological O2 Demand)
● Potential anoxia
● Reduced biodiversity
● Toxic cyanobacterial blooms
● Increased undesirable emissions (CH4, H2S)
● Release of bad odours
● Loss of ecosystem services

Image source: tnluser
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Eutrophication in water ecosystems 

Causes of eutrophication may include:

● Agriculture & husbandry
● Urbanization

○ Habitat destruction/land change
○ Untreated sewage
○ Land erosion

● Floods

=> Indicator / outcome of anthropogenic 
impacts and water quality deterioration.

Image source: earthhow
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Eutrophication in water ecosystems 

To assess eutrophication and algal biomass in water 
ecosystems, researchers often use the 
concentrations of chlorophyll-a (chl-a) as a proxy 
measurement. Chl-a is:

● A pigment found in plants & algae. It is vital for 
photosynthesis and is what gives plants their 
green color.

● Positively correlated with algal biomass.
● Often used as an indicator to monitor water 

quality. For instance, reporting of chl-a 
concentrations is required as part of the EU 
Water Framework Directive (WFD).

Image source: Wikimedia Commons
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Using remote sensing to monitor 
eutrophication dynamics02

To compliment the in-situ measurements of chl-a 
and algal biomass / productivity

To measure other water quality parameters: 
Turbidity, Total suspended matter (TSM), Dissolved 
Organic Matter (DOM), etc. 

But there are challenges:
● Isolating the chl-a signal from other optically 

active compounds 
● The diel (vertical) movements of plankton in 

the water column
● Atmospheric correction

Image source: NASA/Science Photo Library
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To assess eutrophication dynamics via remote 
sensing, it is convenient to measure chl-a 
concentrations due to its optical properties.

Chl-a has higher reflectance in lower 
wavelengths (blue + green regions) at lower 
concentrations.

=> It works very well in marine ecosystems 
but has historically posed challenges in inland 
waters with higher [chl-a]+ humic substances

Using remote sensing to monitor eutrophication dynamics
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Using remote sensing to monitor eutrophication dynamics

Historical overview:

Earliest chl-a estimation via remote sensing started in the 
late 1970s in marine waters [Nimbus 7, Coastal Zone Color 
Scanner (CZCS), based on 2 bands]

SeaWIFS, MODIS, MERIS, Landsat 7,8,9, Sentinel 2, 3 (OLCI) 
have all since been launched that can estimate chl-a.

Satellites with multispectral images ⇒ possibility of more 
complex algorithms to estimate chl-a in inland waters

Making use of neural networks to better isolate and 
identify specific optical characteristics Image source: ESA
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2009-2011 2012 2013-2015 2015-2019

Landsat 4-5 Landsat 7 ETM+ Landsat 8 Sentinel 2

Satellites used in water quality remote sensing
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Wavelengths & bands of satellites used in water quality remote sensing

usna.edu
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Wavelengths & bands of satellites used in water quality remote sensing

Sentinel 2 bands and their characteristics (sentinel.esa.int)

Sentinel-2 properties:

● Time period: 2015 – 2021
● Sentinel 2A and 2B: polar orbit, phased at 

180° to each other
● Equipped with multispectral instrument (MSI) 

with 13 spectral bands
● Wide swath width (290 km)
● Revisit: 5 days at equator (2 satellites)
● Level 1C and 2A (atmospherically corrected)
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Using remote sensing to monitor eutrophication dynamics
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Estimating chl-a concentrations using the C2RCC 
processor:

● It started as ‘The CoastColour’ Project
● It was amended by additional neural 

networks and eventually renamed as Case 2 
Regional CoastColour (C2RCC)

● It is applicable to all past and current ocean 
colour sensors as well as Sentinel-2

● It is available as a package in ESA’s SNAP 
Toolbox

Image source: Brockmann et al., 2016

Calculating chl-a using the SNAP toolkit and 
C2RCC processor03
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Calculating chl-a using the SNAP toolkit and C2RCC processor

Estimating chl-a concentrations using the C2RCC 
processor

The model uses 5 components for scattering and 
absorption:

1. pigment absorption (apig)
2. detritus (adet)
3. gelbstoff (agelb)
4. white scatterer (bwhit) - calcareous 

material
5. typical sediment scatterer (btsm)

Image source: Brockmann et al., 2016
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Calculating chl-a using the SNAP toolkit and C2RCC processor

Downloading freely 
available satellite images:

1. For Landsat images, 
use the USGS Earth 
Explorer website 
[earthexplorer.usgs.
gov]
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Calculating chl-a using the SNAP toolkit and C2RCC processor

Downloading freely 
available satellite images:

You can then add the 
selected product to cart, 
view its metadata, or 
download it directly.
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Calculating chl-a using the SNAP toolkit and C2RCC processor

Downloading freely 
available satellite images:

2. For Sentinel images, 
use the Copernicus Open 
Access Hub 
[scihub.copernicus.eu/dh
us/]

Basic Steps to retrieve satellite image

1. Select the Area of Interest
2. Define Sensing Period
3. Select Satellite Platform
4. Select Product Type
5. Define Cloud Cover
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Calculating chl-a using the SNAP toolkit and C2RCC processor

Choose image(s) 
and add to cart or 
download directly.

Quicklook

Satellite image is not covering the whole area

Add to Cart

Download



Common borders. Common solutions.

Calculating chl-a using the SNAP toolkit and C2RCC processor

from sentinelsat import SentinelAPI, read_geojson, geojson_to_wkt
from datetime import date
api = SentinelAPI('user', 'password', 'https://scihub.copernicus.eu/dhus')

# search by polygon (WKT format), time, and SciHub query keywords
footprint = geojson_to_wkt(read_geojson('/path/to/map.geojson'))

products = api.query(footprint,
date = ('20151219', date(2015, 12, 29)),
order_by = 'ingestiondate',
orbitdirection: 'DESCENDING',

                     platformname = 'Sentinel-2',
producttype = 'S2MSI1C',

                     cloudcoverpercentage = (0, 20))
# download all results from the search
api.download_all(products)
# GeoJSON FeatureCollection containing footprints and metadata of the scenes
api.to_geojson(products)

Sentinelsat:

makes searching, 
downloading and 
retrieving the metadata of 
Sentinel satellite images 
from the Copernicus Open 
Access Hub easy.

[sentinelsat.readthedocs.i
o/en/stable/]
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Calculating chl-a using the SNAP toolkit and C2RCC processor

Sentinel nomenclature:

Identifies a Level-1C 
product acquired by 
Sentinel-2A on the 29th of 
July, 2020 at 9:06:01 AM. 
It was acquired over Tile 
35TKF during Relative 
Orbit 050, and processed 
with PDGS Processing 
Baseline 02.09.

All the bands included in the file are in JPEG2000 format.

In addition, a “True Colour Image” in JPEG2000 format is included 
within the Tile folder of Level-1C products in this format and a manifest 
xml file that tells the computer what is inside the file.
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Calculating chl-a using the SNAP toolkit and C2RCC processor

To process the downloaded 
images, we will use the 
European Space Agency’s (ESA) 
Sentinel Application Platform 
(SNAP) 
[https://step.esa.int/main/dow
nload/snap-download/]

A common architecture for all 
Sentinel Toolboxes is being 
jointly developed by Brockmann 
Consult, SkyWatch and C-S called 
the Sentinel Application 
Platform (SNAP).
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Calculating chl-a using the SNAP toolkit and C2RCC processor

Overview of method:
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Calculating chl-a using the SNAP toolkit and C2RCC processor

To import satellite 
image, go to File → 
Open Product.

Alternatively, you 
can also ‘Drag & 
Drop’ the file into 
the Product Explorer 
window.
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Calculating chl-a using the SNAP toolkit and C2RCC processor

To visualize the 
imported image, 
right click on the 
product and press on 
‘Open RGB Image 
Window’.
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Calculating chl-a using the SNAP toolkit and C2RCC processor

To select an area of 
interest, go to the 
‘Raster’ tab and 
select subset. There 
you can use the 
visual tool, to 
choose your focus 
area.
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Calculating chl-a using the SNAP toolkit and C2RCC processor

To make all image bands of equivalent 
resolution, we’ll need to resample the 
product file.

To do so, go to the ‘Raster’ tab, click on 
‘Geometric’ and then on ‘Resampling’.

We will use B2 as the reference band to 
resample all bands to 10m resolution.
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Calculating chl-a using the SNAP toolkit and C2RCC processor

Alternatively, you can 
perform bulk 
processing using the 
Graph Processor Tool 
(GPT).
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Calculating chl-a using the SNAP toolkit and C2RCC processor

Now to calculate chl-a and 
TSM concentrations, we will 
use the C2RCC processor.

To do so, go to the ‘Optical’ 
tab, then select ‘Thematic 
Water Processing’ and 
choose ‘C2RCC Processors’.

Select the processor 
equivalent to your product 
(e.g. S2-MSI for Sentinel-2 
images).
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Calculating chl-a using the SNAP toolkit and C2RCC processor

There, change the values of the following parameters to match the 
in-situ conditions at the time the image was taken:

● Salinity
● Temperature
● Ozone
● Pressure
● Elevation

+ untick all below boxes 
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Calculating chl-a using the SNAP toolkit and C2RCC processor

Double click on the latest 
created product to expand, 
then click on ‘Bands’ → 
‘conc’. There you will have 2 
newly created images:

● chl-a concentration
● TSM 

You can select the colour of 
each image from a number of 
available templates and 
specify the data range.
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Calculating chl-a using the SNAP toolkit and C2RCC processor

Select the colour of each 
image from a number of 
available templates and 
specify the data range.
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Calculating chl-a using the SNAP toolkit and C2RCC processor

You can export the 
created images by clicking 
on ‘File’ → ‘Export’ and 
selecting on any of the 
desired file formats, 
including GeoTIFF, 
JPEG-2000, NetCFD4, 
ENVI, HDF5, etc.
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The last part of this module will describe 
how to use the PONTOS Data Cube to 
calculate the Total Suspended Matter (TSM) 
in water bodies. 

TSM is an indication of water turbidity (i.e. 
low water clarity), thus high TSM 
concentrations could often indicate low 
water quality, water pollution, and 
anthropogenic pressure. 

Using the PONTOS Data Cube to calculate 
Total Suspended Matter04
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Using the PONTOS Data Cube

To access the PONTOS Data 
Cube: 

1. Go to the PONTOS 
project website 
(pontos-eu.aua.am)

2. Click on the tab entitled 
“PONTOS Platform”

3. Now, click to Access 
Data Cube
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Title of the Slide 

On the PONTOS Data Cube:

1. Register your username
2. Sign in
3. Click on Tools -> Water 

-> Water Quality TSM
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Using the PONTOS Data Cube

Choose the pilot site (location) 
you are interested in to 
perform your query. 
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Using the PONTOS Data Cube

Here you can select:

1. Images from 
specific satellites

2. TSM results 
shown as
a. Average
b. Minimum
c. Maximum
d. Variability

3. Option to 
generate a time 
series animation
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Using the PONTOS Data Cube

Here you can select 
(cont’d):

1. The spatial 
boundaries either
a. via entering 

the exact 
coordinates

b. By drawing a 
polygon

2. The period of 
interest for your 
analysis 
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When you click submit, 
you will notice a TSM 
Query appear under 
running tasks.

Wait till the query is 
completed and a colored 
picture will appear within 
the selected boundaries, 
showing the TSM 
concentrations as 
specified in your query.

Using the PONTOS Data Cube
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To review any of your 
previous queries, you can 
click on ‘Task Manager’ 
→ Water → Water 
Quality TSM.

There you will see a list 
of all your requested 
queries.

Click on Details for more 
information.

Using the PONTOS Data Cube
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Here you will see the 
details of your query and 
be able to download the 
produced images in 
GeoTIFF or NetCDF 
format.

Using the PONTOS Data Cube
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